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I N V E S T M E N T  A C C O U N T  M A N A G E R  

Investment Account 
Manager and Importing 
Captools® Investment 
Software 

ith the recent decision by Captools® Investment Software to no longer 
support their programs for the individual investor, the developers of 
Investment Account Manager have included in IAM an import feature for 

Captools investment data.  This import feature allows the conversion of the most 
common investment transactions from Captools Investment Software into Investment 
Account Manager.  

 W
Please contact Investment Account Manager technical support if you have specific 
questions or errors regarding the Captools import function.   

Email: techsupport@quantixsoftware.com. 

What you will need from Captools 
In order to complete the import process, you should have the following portfolio 
information available for reference.  Depending on which version of Captools you are 
using, the necessary reports may be located under different sets of commands.  Check 
your Captools help documentation for steps on creating the necessary files and reports. 

 A Captools Security List export file containing security descriptive 
information for each security you will be converting.  See steps below for 
creating this security list file.    

 
 A unique Captools transactions list export file for each portfolio you 

will be converting.  See steps below for creating the transactions list file.   
 
 A list of all your currently held securities: their standard security 

symbols, quantity held, cost basis and recent market value for each 
portfolio.  In Captools use the Reports Menu | Position Reports: 
Positions by lot.  

 
 A list of all your transaction activity.  In Captools use the Reports 

Menu | Transactions Reports: All Transactions.  
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 A listing of all sale transactions for each portfolio.  In Captools use the 
Reports Menu | Income Reports: Realized Capital Gains report, for all 
activity dates.  Note: if possible, create this report listing all past sale 
activity by sale date, sorting by oldest to newest activity.  During the 
Captools import, you will be prompted to select a sale application method 
(i.e., First In First Out, Specific Lot Identification, Average Cost) for any 
sale in which only part of the security position has been sold. Note: if 
you have consistently applied all Captools sale records using the First In – 
First Out method, you can select this sale method for automatic 
conversion of past sale activity at the beginning of the conversion process.  
You can also skip sale activity during the conversion process, but you will 
need to later enter those sales directly in Investment Account Manager.  
Captools sale transactions that were entered for all shares owned of a 
security are automatically converted during the import process. 

 
 A listing of bond-like investments (corporate bonds, Government 

bonds, etc.) and how they have been tracked in Captools. For these bond-
like investments, you will need to indicate, at the beginning of the import 
process, a conversion factor that Investment Account Manager requires 
for proper transfer.   

 
 Other reports showing investment income, investment performance, and 

investment transactions for all activity to verify your imported Captools 
data.   

 
 If you have been tracking your daily money market fund (MMF) balances 

in Captools, you can create the matching money market fund in the import 
process. This money market fund will be used as the offset for transaction 
amounts, as well as other cash transferred in or out of the account. If you 
would rather ignore the individual MMF transactions, you can enter a 
single net balance of the MMF as of the date of the conversion at the end 
of the import process. If you choose this method, please be certain to have 
the net balance figure available.  
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Captools Transaction Import Codes and Limitations 
 
Investment Account Manager will convert the following Captools transaction types: 

 DPF:  Deposit Funds (to cash) 
 RCV:  Receive Shares (non-cash transaction) 
 DLV:  Deliver Shares (non-cash transaction).  Use to indicate shares 

delivered out of the portfolio.   
 BUY:  Buy (payment from cash) 
 BYD:  Buy and Deposit (zero net cash change) 
 CBA:  Cost Basis Adjustment (non-cash transaction).  This code is used to 

adjust the cost basis of a security.  
 IN+:  Interest Income (to cash) 
 IN-:  Interest Payment (from cash) 
 IRI:  Interest Income Reinvested (zero net cash change) 
 IOB:  Interest Income on Cash Balance 
 DV+:  Dividend Income (to cash) 
 DRI:  Dividend Reinvested (zero net cash change) 
 DVW:  Dividend Income Withdrawn (zero net cash change) 
 SGD:  Short Term Gains Distribution (zero net cash change) 
 SGR:  Short Term Gains Distribution Reinvested (zero net cash change) 
 SGW:  Short Term Gains Distribution Withdrawn (zero net cash change) 
 CGD:  Long Term Gains Distribution (zero net cash change) 
 CGR:  Long Term Gains Distribution Reinvested (zero net cash change) 
 CGW:  Long Term Gains Distribution Withdrawn (zero net cash change) 
 WDF:  Withdraw Funds (from cash) 
 SLL:  Sell (Proceeds to Cash) 
 SLW:  Sell & Withdraw (zero net cash change) 
 CIL:  Cash in Lieu (of fractional shares, proceeds to cash) 
 ROC:  Return of Capital (to cash) 
 RCR:  Return of Capital Reinvested (zero net cash change) 
 RCW:  Return of Capital Withdrawn (zero net cash change) 
 EXP:  Expenses (paid from cash)  
 MFE:  Management Fee (paid from cash) 
 FEE:  Administrative Fee (paid from cash) 
 OFE:  Other Fee ((paid from cash) 
 MFS:  Management Fee (paid from shares sold, zero net cash change) 
 FES:  Administrative Fee (paid from shares sold, zero net cash change) 
 MFD:  Management Fee (paid from deposited funds, zero net cash 

change) 
 FED:  Administrative Fee (paid from deposited funds, zero net cash 

change) 
 OFS:  Other Fee (paid from shares sold, zero net cash change) 
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 OFD:  Other Fee (paid from deposited funds, zero net cash change) 
 SLS:  Sell Short (proceeds to cash).  
 BYC:  Buy to Cover Short Position (payment from cash).   
 XOP:   Exercised Option (non-cash transaction). If an XOP is for a Put 

exercised, it will be followed by a SLL transaction for underlying security 
 XOP:  Exercised Option (non-cash transaction).  If an XOP is for a Call 

exercised, it will be followed by a BUY transaction for the underlying 
security. 

 SP+:  Split Shares Received (non-cash transaction).  If negative number 
shares in SP+ transaction, represents a reverse split. 

 TXW:  Tax Withheld (from cash). 
 TXD:  Tax Withheld (zero net cash change). 

 
The Captools import function currently does not handle the following transactions 
at this time.  These types of transactions, if any, will be listed on the IAM Import 
Exceptions Report at the end of the import process.   

 DV-:  Dividend payment (on short position) 
 SP-:  Split shares delivered (on short position) 
 Capital Gain Distributions:  CLD (Capital Loss Distribution), SLD (Short 

Term Capital Loss Distribution), Undistributed Capital Gains 
 Bond Discounts / Premiums:  ACR (Accretion on Purchase Discount), 

AMT (Amortization on Purchase Premium),  
 Partnerships / Direct Investments: DST (Partnership Distribution), DSR 

(Partnership Distribution Reinvested), DSW (Partnership Distribution 
Withdrawn). 

 Real Estate / Depreciation: BRW (Borrow of Funds), RPY (Repay Funds), 
RNT (Rent Received), DPR (Depreciation) 

 Tax Related:  ETX (Estimated Tax Adjustment), SCO (Short Term 
Carryover), LCO (Long Term Carryover), TDG (Tax Deductible Gift). 

 Other Transaction Codes:  MMO (Memo Transaction), ERR (Error 
Transaction), SAX (Sub-account Transfer), CMX (Cash / Margin 
Transfer), ROP (Receive Options), NCI (Non-Cash Income). 
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Creating and Exporting the Captools Security List 
 
Note:  a sample Captools Security List CSL_IAM.EXP template file with the required 
items has been provided and is located in your Investment Account Manager 
installation directory if you prefer to use this rather than creating your own.  Copy this 
file to your Captools directory and select this as the format for the export procedure. 

1. Start Captools 
2. Select File Menu | Open.... 
3. Select your Security List from the drop-down menu and Press OK 
4. Select View Menu | Standard View 
5. Select the File Menu | Export choice  
6. Select under the heading Preferences the option to ‘Select’  
7. In the ‘Select Format’ window, select the option for ‘New’  
8. For File Name, use ‘csl_iam.exp’ and then click OK.  
9. Click on the new format file created in step 6, and then click on the ‘Select’ 

button.  
10. Under Preferences, select ‘Edit’ to create a new export format  

a. Field 1: select ‘Symbol’  
b. Field 2: select ‘Description’  
c. Field 3: select ‘Type’  
d. Field 4: select ‘Cusip’  
e. Field 5: select ‘Latest Price’  
f. Field 6: select ‘Latest Prc Date’  
g. Field 7: select ‘Div./Share’  
h. Select ‘OK’  
i. Select ‘Yes’ to save changes to new format.  
j. Select ‘Export’ to create your Captools Security List to file for use 

in importing to Investment Account Manager using for file name 
and type ‘csl_iam.csv’  

 

Creating and Exporting a Captools Portfolio 
Transactions List 
 

Note:  a sample Captools Security List TRANSLST.EXP template file with the 
required items has been provided and is located in your Investment Account Manager 
installation directory if you prefer to use this rather than creating your own.  Copy this 
file to your Captools directory as select this as the format for the export procedure. 

1. If not yet running, Start Captools 
2. Select the File Menu | Open | and select your portfolio 
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3. Select the View Menu | Standard View 
4. Select the File Menu | Export choice 
5. Select under the heading Preferences the option to ‘Select’ 
6. In the ‘Select Format’ window, select the option for ‘New’ 
7. For File Name, use ‘translst.exp’ and then click OK. 
8. Click on the new format file created in step 6, and then click on the 

‘Select’ button. 
9. Under Preferences, select ‘Edit’ to create a new export format using these 

fields with these data items: 
a. Field 1: select ‘Symbol’ 
b. Field 2: select ‘Description’ 
c. Field 3: select ‘TAC’ 
d. Field 4: select ‘Date’ 
e. Field 5: select ‘Quantity’ 
f. Field 6: select ‘$ Amount’ 
g. Field 7: select ‘Commission’ 
h. Field 8: select ‘Trade Fees’ 
i. Field 9: select ‘Accrued Int.’ 
j. Field 10: select ‘Aux. Date’ 
k. Field 11: select ‘Aux. Amount’ 
l. Select ‘OK’ 

10. Select ‘Yes’ to save changes to new format. 
11. Select the ‘Export’ button to save your Captools Portfolio file using .csv as 

file type extension (comma separated values, example joe1port.csv). 
12. Using this new export file format, repeat step 11 for each portfolio you 

wish to export using a unique file name for each portfolio.  Use names 
that you can easily recognize for the import process. 

 

Operational Notes 
 
If during the Captool import process you need to suspend the import process, you can 
click on the Suspend button found on any of the import screens.  This allows you to 
stop the import process, and later begin at this point.  This might be necessary, for 
example, if you are missing past investment reports and need these to verify historical 
transactions. 

Important: you should also use the Suspend button to abort the Captool import 
process for a portfolio if you want to start over after correcting errors in your Captool 
data.  After suspending the conversion, select the File Menu | Add, Edit, Delete 
Portfolios.  Locate and select the Captool portfolio from the Investment Account 
Manager portfolio list.  Use the Delete button to delete the partially imported 
portfolio from Investment Account Manager.  You can then begin the import of the 
portfolio data again. 
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As part of the conversion process, you may be prompted to enter necessary security 
symbols and identify security types.  Use the Captools Security List report as a 
reference while entering these securities.   

During the import process, you will also be prompted to enter security sales 
information for any sales recorded in Captools in which only part of the security 
position was sold.  Use the Captools Realized Capital Gains report as a reference 
while entering these sale applications into Investment Account Manager.  If you have 
consistently applied all Captools sale records using the First In – First Out method, 
you can set a conversion preference for past sale activity.  If you have not used FIFO 
for all previous sale transactions, or you are unsure, each Captools sale transaction can 
be confirmed during the conversion process.  You can choose between Minimum 
Gain, Maximum Gain, First In – First Out, or Specific Identification.   When 
applying sales activity in the conversion process, make certain you properly identify 
those lots sold to match the sales method used previously in Captools.  Sale 
transactions recorded in Captools in which the entire holding was sold will 
automatically be converted during the import process.   

Getting Started: Importing Your Captool Files 

 Click on the File Menu | Import | Captool File. 

 Select the Captool security list and transactions list file created earlier for 
import to Investment Account Manager. 

 Click the Import Data button. 
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Captools - Create a Portfolio 
 
On the Create Portfolio Setup screen, you need to enter a name for portfolio you are 
importing from Captools.  (Note:  Investment Account Manager is designed to easily 
track an unlimited number of portfolios, and we encourage users to take advantage of 
this feature if you have different types of portfolios: i.e. taxable accounts, IRAs, any 
trust accounts, any children accounts, etc.).  Portfolios can be combined on IAM 
reports for aggregate views and reporting totals. 

 

 

 

 Enter the Portfolio Name 
 Enter an optional Investment Objective 
 Use the Next button to continue.  Use the Cancel button to quit the 

Captools import function. 
 

Captools - Import Preferences 
 
Prior to importing your existing Captools data to Investment Account Manager, you 
will need to answer several questions for your Captools security and transaction files.   
Once you have made your selections, use the Next button to continue; or use the 
Cancel Import button if you decide to quit the Captools import in order to print the 
necessary reports as described earlier in this document.   
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 Would you like to create a money market fund for offsetting transactions?  

 Yes:  select yes if you have used in Captools a cash account for 
offsetting transactions, such as buys, sales, dividends, etc.  As your 
Captools transactions are imported, this money market fund in 
Investment Account Manager will account for the cash offsets 
(deposits/withdrawals) automatically.  Create a Security Symbol and 
Security Description for the money market fund.   

 No:  if you prefer to simply enter a balance at the end of the 
Captools import process, leave this choice as ‘No.’    Investment 
Account Manager will ignore all cash offsets during the import 
process. 

 

 Would you like all sales to be done automatically on a FIFO basis? 

 Yes:  if you have consistently applied all Captools sale records using 
the First In – First Out method, you can select the ‘Yes’ option for 
automatic conversion of past sale activity.  

 No:  if you have not used FIFO for all previous sale transactions, or 
you are unsure, select the option for ‘No’.  Each Captools sale 
transaction can be confirmed during the conversion process.  You 
can choose between Minimum Gain, Maximum Gain, First In – First 
Out, Specific Identification or Average Cost (mutual funds).   To 
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accurately import past sale activity, be sure you have created the 
necessary reports as outlined earlier in this document.  

 

 What conversion factor would you like to use for bond-like investments? 

 If you have entered bond-like investments into Captools (corporate 
bonds, Government bonds, etc.), you need to indicate the method 
which you entered these securities.  Please select from the available 
options.  To accurately define Captools bond-like investments, be 
sure you have created the necessary reports as outlined as earlier in 
this document.  Refer to the appendix at the end of this 
document for details on bond conversion.  

 

 Would you like to use BetterInvesting™ Data Services to update information 
for mutual funds that are added? 

 If you subscribe to the BetterInvesting Fund Data services, you can 
enter your subscription information.  Investment Account Manager 
will automatically update fund descriptive information as they are 
imported from your Captools file.  

  

 Would you like to use StockCentral Data Services to update information for 
common stocks that are added? 

 If you subscribe to the StockCentral Data services, you can enter 
your subscription information.  Investment Account Manager will 
automatically update stock descriptive information as they are 
imported from your Captools file. 

 

 Would you like to use SSG data from AAII to update information for 
common stocks? 

 As an alternative to the StockCentral data service, if you subscribe to 
the AAII Stock Investor Pro software, you can choose to use this as 
the source for the necessary stock descriptive information as stocks 
are imported from your Captools file.   
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Captools - Assets to Import 
 
Prior to the import of Captools® transaction data to Investment Account Manager, a 
table is provided that lists the securities in your Captools Security List file that have 
matching transaction data.   

 

 

Assets highlighted in yellow require you to identify either the security symbol or the 
security asset type prior to import.  In most cases, the security symbol and asset type 
will be provided in the Captools security file.   You may add a new symbol, or 
overwrite an existing symbol, by clicking your mouse in the symbol column.  If the 
Captools security has previously been entered into the Investment Account Manager 
asset library, but is not indicated in this form, use the ‘Find’ button to select the proper 
matching symbol from the Investment Account Manager asset library.  

Captools security types will be translated to the matching asset type in Investment 
Account Manager (see below).   For those assets highlighted in yellow, click your 
mouse in the missing required field(s) to complete for the following: 

 Security Symbol: enter the standard security symbol.  For example, you 
would enter ‘INTC’ for Intel.  If the security does not have a standard 
symbol, create a symbol that is indicative of the security being entered.   
You can also use the ‘Find Symbol’ button if this asset has been 
previously entered into the Investment Account Manager current asset 
library, but is not being recognized by your Captools import file.  You 
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might find it helpful to use the Captools Security List report as a 
reference while entering these securities.  

 Asset Type:  using the drop down arrow available, select the asset type 
for the security being entered.  Captools security types will be translated 
to the matching asset type in Investment Account Manager if the 
Captools file has identified type.   Listed below are the Captools security 
types and matching Investment Account Manager types. 

 
 

Captools Security Types    Matching IAM Types 
 
 Cash/Cash Equivalents  Money Market Funds 
 Cash Equivalents   Cash Equivalents 
 Annuities    Other Investments 
 Bond Mutual Funds   Mutual Funds 
 Money Market Funds   Money Market Funds 
 Corporate Bonds   Corporate Bonds 
 Certificate of Deposits   Cash Equivalents 
 Common Stocks   Common Stocks 
 Municipal Bonds   Tax Exempt Bonds 
 Treasury Mutual Funds  Mutual Funds 
 Fixed Income (CD’s)   Cash Equivalents 
 Guaranteed Investment Contracts Other Investments 
 Government Backed Bonds  U.S. Governments 
 Ginnie Mae’s    Agencies 
 Indices     Index 
 Limited Partnerships   Other Investments 
 Stock Mutual Funds   Mutual Funds 
 Preferred Stocks   Preferred Stocks 
 U.S. Treasuries    U.S. Governments 
 Zero Coupon Bonds   Corporate Bonds or U.S. 

Government 
 

Users of Captools that have created other user defined asset types can select 
from the Investment Account Manager asset types available, or use the 
‘Other Investments’ category.   

 

 Use the Save button to record your entries.   

 After all the required information has been entered, use the Next button 
to continue with the import process. 

 Use the Cancel Import button to quit and cancel the Captools import. 
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Captools Importing Process and Transactions  
At the outset of importing Captools securities and past investment transactions, 
Investment Account Manager will automatically download and update common 
stocks, exchange traded funds, and exchange traded funds using the available data 
sources, as selected by the user.   Once the descriptive data has been updated into 
IAM’s asset library, users will be prompted with transaction forms to indicate how to 
handle past Captools entries.  Depending on the Captools transaction history 
imported, these forms include: 

 Captools – Specify Sale 

 Captools – Return of Capital 

 Captools – Transfer 

 Captools – Buy to Cover 

Captools - Specify Sale 
 
When importing prior Captools sale transactions of partial positions for multiple lots 
owned, this screen is used to identify the security sales information.  Use the Captools 
Realized Capital Gains Report as a reference while entering these sale applications.  
Note:  if possible, create this report listing all past sale activity by sale date, oldest to 
newest activity.  This will make the process of matching sale methods used in Captool 
accurate so any remaining cost basis in the security is correct after the conversion 
process.  In Captools use the Reports Menu | Income Reports: Realized Capital Gains 
report, for all activity dates.   
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Here’s how to use the Captools Realized Capital Gains Report to properly import your 
Captool sales data: 

 For each sale record that you need to apply, refer to the upper left hand 
corner of Investment Account Manager’s sale transaction window to 
identify the trade date for the sold security.  Note:  Captools sale 
transactions that were entered for all shares owned of a security are 
automatically imported into Investment Account Manager.  

 Then, using the Captools Realized Capital Gains Report, locate this 
matching security sale record by referring to the ‘Sell Date’ column. 

 Notice that the Captools Realized Capital Gains Report identifies the 
‘Buy Date’ for the sold security.  Using this information, you now can 
locate the corresponding record listed in the Investment Account 
Manager table showing owned shares by matching the Captools ‘Buy 
Date’ with the Investment Account Manager ‘Date Acquired’. 

 Now apply the quantity sold by first clicking the radial dial next to 
‘Specific Identification’.  Note:  if you have consistently applied sales 
using the minimum gain or maximum gain methods provided in 
Captools, you can select these methods in Investment Account Manager 
for proper conversion. 

 Locate the lot to be used for the sale, then point and left click your 
mouse in the Quantity Applied column and enter the quantity sold from 
this holding.   

 To sell all quantity held in a lot, point and left-double click in the 
Quantity Applied column and Investment Account Manager will default 
to this field the total number of shares held in this lot, or the balance of 
the shares "Left to Apply".  You can edit the number of shares to apply 
as necessary.  

 Continue to specifically identify which current position lots to use in this 
sale transaction by referring to the Captools Realized Capital Gains 
Report until all quantity sold has been applied.   As you apply the sale to 
specific lots, the "Quantity Left to Apply" amount is automatically 
reduced, until you reach zero.  At that point the Save button becomes 
active. Use this selection to save the sale transaction and continue with 
the import process. 

 Suspend:  if during the import process you need to suspend the 
program, you can click on the ‘Suspend’ button.   This allows you to stop 
the Captool import process, and later begin at this point.  This might be 
necessary, for example, if you are missing past investment reports and 
need these to verify historical transactions. 

 Undo Applied: use this choice (at anytime) to undo all sale lot 
applications.  The value left to apply will reset to the total shares sold, 
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and all lot sizes will be restored to their initial amounts.  You can then 
begin the sale application again. 

 Skip This Sale:  use this button to skip any sale applications during the 
import process.  You will need to enter these later in Investment 
Account Manager.  Any skipped transactions will be listed on the final 
transactions report summarizing all activity.  Note:  if you skip sale 
activity for an asset during the import process, share balances shown 
prior to subsequent sale activity for the same asset will be incorrect.  This 
is likely caused by stock split activity that occurred between the skip sale, 
and the subsequent sale.  By skipping the sale activity, the import 
program is using Captool data to adjust shares not owned.  To prevent 
this problem, we suggest you suspend the procedure, obtain the 
necessary information to complete the sale application, and then 
resume the Captool import process, entering the sale activity as it 
occurred. 

 
Note:  in the case of mutual funds, you have the ability to apply sales using the 
Average Cost method.  Follow the method reported by Captool or the method 
reported to you by the mutual fund company. 

 Average Cost Single-Category: in the single-category method, the 
average cost of ALL shares owned at the time of each sale is derived, 
regardless of how long the shares have been held.   This includes those 
shares acquired with reinvested dividends or capital gains distributions.  
The basis of the shares is the basis of ALL shares of that mutual fund in 
the portfolio at the time of each sale.  Even though you use only one 
category to compute basis, you may have short-term or long-term gains 
or losses.  To determine holding period, the IRS assumes the shares sold 
are considered to be those acquired first.  Investment Account Manager 
applies the sale automatically as first in – first out.   

 Average Cost Double-Category: in the double-category method, all 
shares in a portfolio at the time of sale are divided into two categories: 
short-term and long-term. The adjusted basis of each share in a category 
is the total adjusted basis of all shares in that category at the time of sale 
divided by the total shares in the category.  The specific identification 
method is then used to indicate from which category the shares are to be 
sold.   
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Captools - Return of Capital 
 

This screen is used to identify the application of a Captools return of capital (ROC) 
transaction when more then one security lot was owned at the time the return of 
capital was received.    

 

 

The top portion of this screen indicates the record date, security symbol and security 
description.   The lower portion of this screen lists the existing lots held of the asset.  If 
you owned more than one lot of the asset at the time the ROC was received, you can 
choose one of two methods to apply the distribution. 

 Apply proportionally to all lots: this is the defaulted choice for the 
ROC application.  This choice will reduce proportionally the cost basis of 
all existing lots of the asset based on shares held. 

 Apply to individual lot: use this choice to select (point & double click) a 
single lot to apply the return of capital distribution. 

 Save: use this selection to save the return of capital transaction and 
continue with the Captools import. 

 Use the Suspend button to stop the Captools import process, and later 
begin at this point.  This might be necessary, for example, if you are 
missing past investment reports and need these to verify historical 
transactions. 

 Use the Skip this Transaction button to skip this return of capital 
transaction.  You will need to enter these later in Investment Account 
Manager.  Any skipped transactions will be listed on the final transactions 
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report summarizing all activity.  Note:  if you skip activity for an asset 
during the import process, cost basis shown later in this import process 
for the same asset will be incorrect.  To prevent this problem, we 
suggest you suspend the procedure, obtain the necessary 
information to complete the ROC application, and then resume the 
Captool import process, entering the ROC activity as it occurred. 

 
Note:  it is important to match the method used in Captools so any remaining cost 
basis in the security is accurate after the conversion process.   If the remaining cost 
basis shown after the ROC has been applied does not match that reported in 
Captools after the import is complete, you can edit the adjusted cost basis by selecting 
IAM’s Transactions Menu | Add, Edit, Delete Transactions | select the individual 
asset’s purchase record | select the Edit/Delete tab | select the Current Balance record 
| and then edit the net amount as necessary.   If the remaining cost basis shown after 
the ROC has been applied does not match that reported in Captools, and the security 
lot has been used in a subsequent sale application, the realized capital gains shown on 
the Investment Account Manager Sold Securities report will not precisely match that 
reported on the Captools Realized Capital Gains Report.  We suggest you apply the 
sale now, and when the import is completed, undo the sale,  make the necessary cost 
basis adjustments to the sold shares, and then re-enter the sale directly in IAM.    

Captools - Transfer 
 
This screen is used to identify the application of a Captools transfer (deliver = DLV) 
transaction out of the portfolio when more then one security lot of the issue was 
owned at the time of the deliver activity. 
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The Captools deliver transaction indicates:  

 Transfer Date: the date of the transfer you are recording. 
 Quantity Transferred: the quantity of the transfer.     
 Market Price: the market price on the date of the transfer. 
 Market Value: the market value of the quantity transferred on the date of 

the transfer. 
 
Note:  Investment Account Manager’s transfer feature allows you to assign what 
values to use for the cost basis of shares transferred.  Verify the basis you assigned in 
Captools, and then select the proper radial button to assign original cost basis and 
basis date for transferred shares, or to assign current market values as cost basis 
and transfer date for basis information (for inherited shares, gifts to charity, required 
distributions from non-taxable accounts).  In most cases, the IRS requires the original 
cost basis and basis date be used for shares transferred.  Check with a tax advisor or 
appropriate IRS publications as necessary. 

You can then selectively apply the transfer to any of the specific lots you own.  This 
enables you specifically identify which lots to use in the transfer (considering the 
holding period and cost basis of the each lot and matching the delivered shares in 
Captools).    

 Identify the lot to be used in the transfer procedure, and then left-click in 
the quantity transferred column to enter the quantity for the transfer from 
this holding.   

 
 To transfer all quantity held in a lot, point and left-double click in the 

quantity transferred column and Investment Account Manager will default 
to this field the total number of shares held in this lot, or the balance of 
the shares “Left to Apply.”  You can edit the number of shares to apply as 
necessary.  

 
 Continue to specifically identify which current position lots to use in this 

transfer transaction until all quantity transferred has been applied.   As you 
apply the quantity transferred to specific lots, the “Left to Apply” amount 
is automatically reduced, until you reach zero “Left to Apply.” 

 
Button Choices: 

 Use the Save button to save the transfer. 
 Use the Undo button to undo all transfer lot applications.  The value left 

to apply will reset to the total transferred, and all lot sizes will be restored 
to their initial amounts.  You can then begin the procedure again.   

 Use the Cancel button to cancel this transfer activity. 

 Use the Suspend button to stop the Captools import process, and later 
begin at this point.  This might be necessary, for example, if you are 
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missing past investment reports and need these to verify historical 
transactions. 

 Use the Skip this Transaction button to skip this transfer (deliver) 
transaction.  You will need to enter these later in Investment Account 
Manager.  Any skipped transactions will be listed on the final transactions 
report summarizing all activity.  Note:  if you skip activity for an asset 
during the import process, shares and cost basis shown later in this 
import process for the same asset will be incorrect.  To prevent this 
problem, we suggest you suspend the procedure, obtain the 
necessary information to complete the transfer application, and 
then resume the Captools import process, entering the transfer 
activity as it occurred. 

 

Captools - Buy to Cover (short sales) 
 
If during the Captools import process you have previous Buy to Cover transactions, 
this screen is used to identify ‘buy to cover’ transactions for any previous short sales 
recorded in Captools in which only part of the short security position was covered.  
Use the Captools Realized Capital Gains Report as a reference while entering these 
‘buy to cover’ applications.  Note:  create this report listing all past short activity by sale 
date, oldest to newest activity.  This will make the process of matching methods used 
in Captools accurate so any remaining short positions are correct after the conversion 
process.  In Captools use the Reports Menu | Income Reports: Realized Capital Gains 
report, for all activity dates.   
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Here’s how to use the Captools Realized Capital Gains Report to properly import your 
Captools sales data: 

 For each ‘buy to cover’ record that you need to apply, refer to the upper 
left hand corner of IAM’s sale transaction window to identify the trade 
date for the short security.  Note: Captools ‘buy to cover’ transactions 
that were entered for all shares shorted of a security are automatically 
imported into Investment Account Manager.  

 Then, using the Captools Realized Capital Gains Report, locate this 
matching security short/covered record by referring to the ‘Sell Date’ / 
‘Buy Date' column. 

 Notice that the Captools Realized Capital Gains Report identifies the 
‘Sell Date’ for the covered lot of the security.  Using this information, 
you now can locate the corresponding record listed in the IAM table 
showing shorted shares by matching the Captools ‘Sell Date’ with the 
IAM ‘Date Shorted’. 

 Now apply the quantity covered by first clicking the radial dial next to 
‘Specific Identification’.  Note: if you have consistently applied sales 
using the minimum gain or maximum gain methods provided in 
Captools, you can select these methods in Investment Account Manager 
for proper conversion. 

 Locate the lot to be used for the ‘cover’, then point and left click your 
mouse in the Quantity Applied column and enter the quantity ‘covered’ 
from this short holding.   

 To ‘cover’ all quantity held short in a lot, point and left-double click in 
the Quantity Applied column and IAM will default to this field the total 
number of shares held in this lot, or the balance of the shares “Left to 
Apply.”  You can edit the number of shares to apply as necessary.  

 Continue to specifically identify which short position lots to use in this 
‘cover’ transaction by referring to the Captool Realized Capital Gains 
Report until all quantity ‘covered’ has been applied.   As you apply the 
buy to cover to specific lots, the "Quantity Left to Apply" amount is 
automatically reduced, until you reach zero.  At that point the Save 
button becomes active. Use this selection to save the buy to cover 
transaction and continue with the import process. 

 Suspend: If during the import process you need to suspend the 
program, you can click on the ‘Suspend’ button.   This allows you to stop 
the Captool import process, and later begin at this point.  This might be 
necessary, for example, if you are missing past investment reports and 
need these to verify historical transactions. 

 Undo Applied: use this choice (at anytime) to undo your entries.  The 
value left to apply will reset to the total shares ‘covered’, and all lot sizes 
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will be restored to their initial ‘short’ amounts.  You can then begin the 
‘buy to cover’ application again. 

 Skip This Buy:  use this button to skip any ‘buy to cover’ applications 
during the import process.  You will need to enter these later in 
Investment Account Manager.  Any skipped transactions will be listed on 
the final transactions report summarizing all activity.  Note:  if you skip 
Buy to cover activity for an asset during the import process, share 
balances shown prior to subsequent buy to cover activity for the same 
asset will be incorrect.  To prevent this problem, we suggest you 
suspend the procedure, obtain the necessary information to 
complete the buy to cover application, and then resume the 
Captool import process, entering the activity as it occurred. 

 

Captools - Suspend Import 
 
If during the conversion process you need to suspend the Captools import program, 
you can click on the Suspend button.    

 

 
This allows you to stop the conversion, and later begin at this point.  This might be 
necessary, for example, if you are missing past investment reports and need these to 
verify historical transactions.  To resume the Captools import, select the File Menu | 
Import | Captools File. 

 You should also use the Suspend button to abort the conversion process 
for a Captools portfolio (for example, if you want to start over after 
correcting errors in your Captools data).   

 After suspending the conversion, select the Captools portfolio from the 
Investment Account Manager portfolio list (File Menu | Add, Edit, 
Delete Portfolios).  

 Use the Delete button to delete the partially imported portfolio from 
Captools. You can then begin the Captools import of the portfolio data 
again.   
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Captools – Verifying Results 
 
At the completion of the Captool import process, you should verify converted data by 
printing several of the Investment Account Manager reports.  Use these reports to 
compare with those created from Captools and referenced for the import process.  

 If your Investment Account Manager money market fund balance does 
not match your Captools ending cash balance, you can manually edit the 
balance derived at the end of the import process.  An adjusting entry 
will be recorded into the Investment Account Manager transaction 
activity ledger.  Be certain to review all transactions listed as ‘not 
imported’ on the Investment Account Manager / Captools Transaction 
Import report for the missing offset transactions.  

 At the end of the Captools import, you’ll be prompted to review an audit 
report listing all activity that was properly imported into the newly 
created portfolio.  Please carefully review this report to verify accuracy 
with the transaction activity report created in Captools.   

 When complete with the import, Investment Account Manager will 
recalculate the IAM home page, reflecting imported Captool data.  

 Using the tabs provided on the Investment Account Manager Home 
Page 

o Click on the tab labeled Portfolio Values, and then click on the 
‘report’ button in the upper right corner of this tab.  Use this 
report to compare holdings, quantities, and cost basis. 

o Click on the tab labeled Income Received, for Select Range 
select ‘Include All Dates’, then click on the ‘report’ button in 
the upper right corner of this tab.  Use this report to compare 
investment income, interest, and capital gain distributions 
received. You should also compare results for other dates ranges, 
including for all activity. 

o Click on the tab labeled Sold Securities, for Select Range select 
‘Include All Dates’, then click on the ‘report’ button in the 
upper right corner of this tab.  Use this report to compare 
realized gains and losses for sold issues.  You should also 
compare results for other dates ranges, including for all activity. 

o Refer to the Reports Menu | Portfolio for other reports you can 
print to compare transactions, performance, and other data as 
necessary. 

 Be sure to use the File Menu | Backup Data choice to backup 
portfolios as you convert them from Captools. 
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 If you find any discrepancies, please review your Captools data, or edit as 
necessary directly in Investment Account Manager by selecting the 
Transactions Menu | Add, Edit, Delete Transactions.   

 

If you have questions with editing, please refer to the online help system, or 
contact Investment Account Manager support by emailing 
techsupport@quantixsoftware.com. 
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Appendix  

Conversion Factors for Captools Bond-Like 
Investments 
 
If you have entered bond-like investments into Captools (corporate bonds, 
Government bonds, etc.) you will need to indicate the method which you entered these 
securities.  The conversion factor will be applied for all bond-like investments 
imported, so verify you have used a single consistent entry method in Captools.   To 
accurately define Captools bond-like investments, be sure you have created the 
necessary reports as outlined on pages 1 and 2 of this document.  

 

Captools Examples: 

 If in Captools you entered 25 units for a bond-like purchase with a total cost of 
$25,000, select the option for conversion factor equals 1.  This equates to 1 
bond entered as 1 unit, purchase price of $1000.    

 If in Captools you entered 250 units for a bond-like purchase with a total cost 
of $25,000, select the option for conversion factor equals 10.  This equates to 1 
bond entered as 10 units, purchase price of $100.    

 If in Captools you entered 2500 units for a bond-like purchase with a total cost 
of $25,000, select the option for conversion factor equals 100.  This equates to 
1 bond entered as 100 units, purchase price of $10.    

 If in Captools you entered 25,000 units for a bond-like purchase with a total 
cost of $25,000, select the option for conversion factor equals 1000.  This 
equates to 1 bond entered as 1000 units, purchase price of $1.    
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